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Export ing from the HyperImage Editor

1. �Start Export 
Select Project/Export… in the HyperImage Editor

2. �Export Settings 
If you want to export all images, activate the option Export Binary Data of Views (including Preview) in the Export 
Project window. This step is not necessary if no new images have been added since the last export. In the Post Proces-
sing Tool list, select PostPeTALGenerator, Leuphana University, Lüneburg.

3. �Define Export Directory 
Click the Export… button. In the file selection window select a local directory in which all of the files (the PeTAL file 
project.xml and, where applicable, the .img folder with all of the images) are to be stored. The export process starts 
automatically.  
If a post-processing tool has been selected to convert the exported files, this will start automatically once the export 
process has finished. 

Convert ing using the PostPeTALGenerator

The PostPetalGenerator …
• �creates an index for the HyperImage Reader’s search function,
• �analyses all links in order to backtrack interactive structures,
• �fragments the exported XML file (PeTAL format) into smaller XML files (postPeTAL format),
• �generates HTML files for direct access to specific elements of the HyperImage project and for search engines to find text-

based content,
• �generates new image files with different zoom sizes,
• �generates thumbnails of all layers, enabling them to be displayed in groups,
• �attempts to generate miniature images of the lines of URL objects.

Note 1: If you want to generate an index, a ‘stop word list’ can be used for each project language, which contains words 
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that are not to be included in the index. All such lists are compiled in a stopwords.xml file. Such a file can be found in the 
postPeTAL Generation folder in the publication package. You can amend these lists and add new languages. To use the stop 
word list, the stopwords.xml file has to be stored in the same directory as the previous project.xml file exported from the 
HyperImage Editor.
If you want to amend the stopword.xml file, use a text editor that is capable of saving unformatted text in UTF-8 format. 
(On a Mac, for example, ‘BBEdit’ or ‘TextEdit’, on Windows, ‘NoteTab Light’, for example.) Please make sure that the XML 
syntax is retained. 

Note 2: All the settings in the PostPeTALGenerator are automatically stored in properties.xml in the same directory as the 
project.xml file exported from the HyperImage Editor. If this file is already available during a later conversion, the settings 
from the previous conversion will initially be used, but can be amended as required. 

1. �Select the file to be converted 
In the PostPetalGenerator window, open the freshly exported file project.xml. Click Choose File and then select the 
file in the file selection window from the location previously indicated as the export directory in the HyperImage Editor. 
Then click Start.

2. �Define the weighting of the metadata for the object  
In the Settings window click the Metadata Ranking tab. Then drag the metadata until it us in the correct position. 
Alternatively, use the Move up and Move down buttons to position the metadata.  
The metadata containing the Annotations on the objects written by the HyperImage authors has to be moved to the 
top line. In the HyperImage Reader, metadata are displayed on the Annotations tab together with annotations relating 
to the views and the layers.  
Below this, the sequence of metadata reflects their significance: the higher metadata is positioned the more important 
it is. This metadata is presented in this sequence on the Metadata tab in the HyperImage Reader. In addition, the meta-
data in the second and third lines appear in the information lines in the HyperImage Reader, above the view and in the 
title line of the light table elements. (The number of metadata items displayed in the information line can be changed 
using the hi-prefs pre-settings in the XML file. For more information see Changing the Display of the HyperImage 
Reader).  
The top-positioned metadata below the annotations - i.e. the metadata in the second position – also an additional 
special meaning. This is used in several parts of the HyperImage Reader to label objects:  
• in the flags when mousing-over the thumbnails of the group  
• in the flags when mousing-over the thumbnails displayed as results of the All References, All Back References, All 
Views and Inscriptions and History functions.  
• in the list of hits on the Search tab. 
It therefore makes sense to position the title of the object, or an equivalent, in the second place. 

3. �Define the groups, project texts and light table in the menu of the Reader.  
In the Group Visibility, Text Visibility and Light Table Visibility tabs, highlight those elements that the user can retrie-
ve directly from the pull-down menu on the upper edge of the HyperImage Reader. Non-highlighted elements can only 
be retrieved indirectly by using links or from the groups.  
Use the mouse to drag groups, texts and light tables to their right position. Here you can also use the Move up and 
Move down buttons to place these items in the right sequence. These elements appear later in the HyperImage Reader 
menu in the same sequence they are listed here.

4. �Define options for the re-generation of images  
In the Options tab of Select Image Options, you can define whether you want to Generate Additional Images, Gene-
rate Layer Thumbnails or Generate URL Thumbnails. The recalculation of images will slow down performance. If no 
new images have been added since the last export, the first option, Generate Additional Images, should be deactivated.  
 
Generating additional images accelerates the display of images in the HyperImage Reader. If a variety of images are 
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available, the system does not always load the largest version; instead it loads an image file that matches the actual 
space available. However, this does require a little more time and more memory. At least 2GB of memory should be 
available for this option. All the same, if you are working with particularly large images storage problems cannot be 
fully excluded. If the conversion process cannot be completed, try deactivating the Generate Additional Images option 
and repeating the process.  
 
The Layer Thumbnails are small sections of images from the view that each display a layer in its proximate surroundings. 
The layer is superimposed on the view as half transparent. In the HyperImage Reader, layer and URL thumbnails are used 
in presenting groups and for functions such as Back reference, Reference and History.  
 
URL thumbnails are miniature images of linked webpages. The thumbnail will not be generated if the target link im-
plements objects such as Adobe Flash, PDF or video. The generating process will time-out if the complete loading of 
the webpage exceeds a limit (roughly 10 seconds). If there is no URL thumbnail, the HyperImage Reader will generate a 
text-based replacement.

5. �Define the interface required  
Likewise, in the Options tab of the Select Skin section you can later select settings for the general display of the Hy-
perImage Reader. This function is currently not available.

6. �Start conversion 
When you have checked the settings, click the Save Settings & Continue button in the Settings window. The settings 
are then stored in the properties.xml file and defaulted in the next session. The conversion process then begins. Depen-
ding of the size of the project and the options selected, this can take anything from a couple of minutes to a couple of 
hours.   
 
The process ends when the line FINISHED appears in the log list at the bottom. In addition, a short tone can be heard. 
The PostPeTALGenerator can now be closed (click the Quit button). After the conversion, all newly generated files are 
found in the same directory as the project.xml file.  
 
N.B. If you want to use the PostPeTALGenerator offline, start it by entering the following in the command line:  
java -Xmx1000m -jar and then the path to the file PostPetalGenerator.jar 
The number 1000 describes the assigned memory in MB. 

Publ ishing with the HyperImage Reader

To publish material, place the newly-generated files and the Reader files (from the Publication package) in a common 
directory on your Internet server or copy them to a storage medium (e.g. CD ROM, DVD ROM, flash drive).

For online publications:
• Folder ‘postPetal’,
• Folder ‘content’,
• File ‘start.xml’,
• the folder with the image files (‘img’),
• Folder ‘resources’ with the complete contents (except back-ups),
• File ‘index.html’
• File ‘AC_RunActiveContent.js’,
• File ‘HyperImageReader.swf’.

For offline publications (e.g. on CD ROM):
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• Folder ‘postPetal’,
• File ‘start.xml’,
• the folder with the image files (‘img’),
• Folder ‘resources’ with the complete contents (except back-ups),
• Application ‘HyperImageReader.app’ (for Mac OS) or ‘HyperImageReader.exe’ (for Windows).

Author ’s  Credits

HyperImage authors can add their own credits/imprint to their project. In the HyperImage Reader, this appears after laun-
ching the function File/Credits. Credits can be added for each project language and are stored as text files in the resour-
ces folder. File names follow the logic credits_languagecode.txt, i.e. credits_de.txt.  
 
Some HTML labels are used to format the credits. Sample files for credits available in the publication package in the re-
sources folder provide information on possible formatting options. 

Project Icon

In the top left-hand corner of the HyperImage Reader, there is space for a project icon of 48 x 48 pixels. This icon can be 
replaced by your own project-specific image. To do this, add a PNG file of 48 x 48 pixels named home.png in the resources 
folder. In the HyperImage Reader, this icon functions as a button to navigate to the start element of the project. 

Changing the Display of the HI Reader

If you want, you can change the display of the HyperImage Reader to match your own personal style or the nature of the 
project. To do this, open the hi_prefs.xml file in the resources folder using a text editor capable of saving unformatted text 
in UTF-8 format. (On a Mac, for example, ‘BBEdit’ or ‘TextEdit’, on Windows, ‘NoteTab Light’, for example.) A brief descripti-
on of the significance of the parameters is given in the commentary. 
Please make sure that the XML syntax is retained. Even the smallest syntax error will make the file unreadable. To be on 
the safe side, make a back-up of the original hi_prefs.xml file. 

Extending the Reader to Include Other Languages

You can define a new language version for all the text elements in the Reader in the hi_strings.xml file which can be found 
in the resources folder. The new language is only available in the Reader when it has been selected as a project language 
in the HyperImage Editor. To do this you need a text editor that is capable of storing unformatted text in UTF-8 format. 

1. �Duplicate language table 
Copy an existing language table from hi_strings.xml, e.g. the section from <table xml:lang=”de”> to </table>, and paste 
the copied section back into the bottom of the table. 

2. �Translate language elements 
Change the old language code (e.g. de) in the newly-inserted language table for the new language code and overwrite 
all text elements in the new language. You can find the new language code in the project settings for the HyperImage 
Editor (click Project/ Project Settings).

3. �Insert menu bar for the new language in all language tables  
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Make sure that the menu item for the new language is available in all languages. Where necessary, add a line in the 
upper section of the individual language tables as follows: <str key=“MENU_LANG_xy“>Xylanguage</str>. For xy, add 
the new language code and for Xylanguage the name of the new language. The expression “MENU_LANG_xy” is case 
sensitive. In the HI Reader, the name Xylanguage will appear as a new item in the File menu. This item is used to switch 
to the new language. 

Ideas for the Start Page of a HyperImage Project

The start page of a HyperImage project is of particular important since this is usually the first contact between the visitor 
to the website and the content of the project. It is therefore important that the page is friendly but meaningful. 
In most cases it is not particularly wise to use a normal element from the HyperImage project to introduce the project. 
Give this some thought – it might be more appropriate to use a special start image especially designed for the purpose: 
Such an image would then have to be imported into the project in the same way as you would import a view of an object. 
The image could then be accompanied by the title of the project, maybe a sub-title, the name of the project authors and 
the period the project covered. A graphic image (maybe an image from the project, an outline or a logo) can serve as a vi-
sual introduction to the theme. Navigation options can include a large polygon across the whole page linked to the desired 
start element from the project, or several smaller polygons laid across an outline or a diagram, for example. The second 
option allows for a differentiated introduction to the project. 
Make sure that such a start image is not too small: if ithe HyperImage Reader enlarges the image on a monitor it may 
appear too blurred. An image size of around 1600 x 1200 pixels is usually sufficient even for larger monitors. Adobe Photo-
shop is a useful image editing program to create such as start image.  
Whether annotations are included for the title page in the Editor is a matter of taste. If you decide to do this, the Anno-
tations will then appear on the right hand side of the HyperImage Reader. On the title page, this might be seen as a little 
irritating. On the other hand, a table of content or a sitemap can be included in the Annotations. As an alternative, this 
information can be placed on a second title page, perhaps also a dedicated text especially for this purpose.

Transferr ing a Light Table from the HI Reader to the HI Editor

If you want to insert a light table permanently and with links in a HyperImage project, you need to copy it from the Hyper-
Image Reader to the HyperImage Editor. 

1. �Creating and naming the light table in the HI Reader  
When you set up a light table, remember that not all future users will have a large monitor. If you want to avoid the 
unnecessary use of the scroll bar, restrict the overall size to that of a medium-sized monitor.  
 
Make sure that the light table is allocated a name in all project languages in the HyperImage Reader: Click Light Table/
Name Light Table and enter the name in the current project language in the appropriate field. Where applicable, 
change to other project languages (File menu) to enter the name there also. 

2. �Generating the XML code of the light table  
Use the menu function Light Table/XML in Clipboard of the HyperImage Reader to generate the XML code for the 
current light table. This is store on the clipboard of your computer. 

3. �Creating a new light table in the HI Editor  
In the HyperImage Editor, select a group to which the light table is to be added. From the Tools menu, (the cog button 
at the bottom of the window) select New/New Light Table. 

4. �Transfer the XML code to the new light table  
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Replace the defaulted content of the Light Table Editor window with the XML code on the clipboard (select content 
and paste new content using ctrl/cmd+V) Click the Save button (disk icon) and close the Light Table Editor. 

Direct L inking to Specif ic Elements in a Project

In the Internet, it is possible to link directly to a specific element within a project (to groups, objects, inscriptions, views, 
layers, light tables and texts) instead of to the start/index page of a HyperImage project. To do this, enter a specific HTML 
document in the content folder as the hyperlink target instead of the usual project directory or the index.html document. 
The content folder is generated by the postPeTALGenerator and filled with HTML files for all elements of the project. The 
folder should be stored on the Internet server in the same directory as the Flash file HyperImageReader.swf. 
The HTML document that is linked bears the name of the ID of the target element. Example: To create a direct link to the 
element with the ID ‘L12345’, the file ‘L12345.html’ needs to be opened. If the normal URL of the project is www.adc.de/
index.html, the URL of the special element would be www.abc.de/hi-content/L12345.html. 

To find the current URL of a HyperImage project, use the menu function File/Display Current URL in the HyperImage 
Reader. The complete URL (including the content directory and the HTML file of the element) will then be displayed in the 
information line and also copied to the clipboard .


